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Deployment planning and preparation
Before you begin installing the StorageGRID Webscale system, you must be familiar with all steps
and requirements necessary to successfully complete the installation procedure.
The StorageGRID Webscale installation procedure assumes that you are familiar with the
architecture and operational functionality of the StorageGRID Webscale system. If the StorageGRID
Webscale system includes StorageGRID Webscale appliance Storage Nodes, you must be familiar
with all steps and requirements necessary to successfully complete the StorageGRID Webscale
appliance installation procedures.
You can deploy a single site or multiple sites at installation time; however, all sites must meet the
minimum requirement of having at least three Storage Nodes.
The installation procedure consists of two steps:
1. Deployment: Deploy virtual grid nodes in the hypervisor. Deploying grid nodes creates virtual
machines that are ready for configuration. Deploy any StorageGRID Webscale appliances as nonvirtual grid nodes.
2. Configuration/Installation: Configuring the StorageGRID Webscale system and completing the
installation.
There are two methods to install a StorageGRID Webscale system:
•

You can perform deployment and installation as detailed in the "Performing the installation"
section. After deployment, you configure the system using the Grid Management Interface.

•

You can automate grid node deployment, installation, and configuration using the deployment
tool as detailed in the "Automating the installation" section:
◦

Deploy virtual nodes using the provided deployment bash script.

◦

Deploy appliances using the provided Python deployment script.

◦

Configure the grid using the provided Python configuration script, or directly use the Rest API
as detailed in the "StorageGRID Webscale API overview" section to automate the installation
and configuration of grid nodes.

Important: Before starting the installation procedure, the StorageGRID Webscale deployment
must have been planned and all required hardware installed, connected, and configured to
specifications. Hardware specific installation and integration instructions are not included in the
StorageGRID Webscale installation procedure.
Important: Before starting the installation procedure, you must understand the available network
configuration options and how each network option should be implemented on grid nodes. See the
"Networking requirements" section for more information.

You must understand the grid topology you are deploying, and you must gather all networking
information in advance, including the IP addresses to assign to each grid node, and the IP addresses
of the domain name system (DNS) and network time protocol (NTP) servers that will be used.

Preparing for installation
Before you begin installing the StorageGRID Webscale system, you must be familiar with all steps
and requirements necessary to successfully complete the installation procedure.
The StorageGRID Webscale installation procedure assumes that you are familiar with the
architecture and operational functionality of the StorageGRID Webscale system. If the StorageGRID
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Webscale system includes StorageGRID Webscale appliance Storage Nodes, you must be familiar
with all steps and requirements necessary to successfully complete the StorageGRID Webscale
appliance installation procedures.
Important: Before starting the installation procedure, the StorageGRID Webscale deployment
must be planned and all required hardware installed, connected, and configured to specifications.
Hardware specific installation and integration instructions are not included in the StorageGRID
Webscale installation procedure.

Required materials
Before you install StorageGRID Webscale, you must gather and prepare required materials.
Item

Notes

NetApp
StorageGRID
Webscale license

You must have a valid, digitally signed NetApp license.

StorageGRIDWebscaleversion-SHA.tgz

You must have downloaded the StorageGRID Webscale installation file
(StorageGRID-Webscale-version-SHA.tgz) and extracted the
required files on your service laptop. For more information, see

Note: A non-production license is included in the StorageGRID
Webscale installation file that can be used for testing and proof of
concept grids.

Downloading and extracting the StorageGRID Webscale installation files
on page 7.
OpenStack software
and documentation

For the current supported versions of OpenStack software, see the
Interoperability Matrix.
NetApp Interoperability Matrix Tool.

Service laptop

The StorageGRID Webscale system is installed through a service laptop.
The service laptop must have:

StorageGRID
Webscale
documentation

•

Network port

•

Telnet and SSH client (for example, PuTTY)

•

Supported web browser

•

StorageGRID Webscale 10.3 Administrator Guide

•

StorageGRID Webscale 10.3 Release Notes

Related tasks

Downloading and extracting the StorageGRID Webscale installation files on page 7
Related references

Web browser requirements on page 15
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Downloading and extracting the StorageGRID Webscale
installation files
Before you can use StorageGRID Webscale features, you must download the software from the
NetApp Support Site.
About this task

You must expand using the same version of software that is currently running on the grid.
Steps

1. Access the NetApp Support Site at mysupport.netapp.com.
2. Download the StorageGRID Webscale installation file (StorageGRID-Webscale-versionSHA.tgz).
3. Extract the files from the installation .tgz file.
You will need to choose the files you need from the following list. The set of files you need
depends on your planned grid topology and how you will deploy your StorageGRID Webscale
grid.
README

A text file that describes all of the files
contained in the StorageGRID Webscale
download file (StorageGRID-Webscaleversion-SHA.tgz).

NLF000000.txt

A non-production NetApp License File that
you can use for testing and proof of concept
deployments.

/openstack/NetApp-SG-versionSHA.vmdk

The virtual machine disk file that is used to
create all grid node types from an OpenStack
Glance image.

/openstack/flavor.yaml

The OpenStack Heat template file for creating
a flavor for your StorageGRID Webscale
system. Using this file is optional. This file
requires administrator access and possibly a
patch to Heat.

/openstack/security-group.yaml

The OpenStack Heat template file for creating
a security group for your StorageGRID
Webscale system.

DHCP network deployment templates
/openstack/openstack-primaryadmin.yaml

The OpenStack Heat template file for
deploying the primary Admin Node using
DHCP for IP address assignment.

/openstack/openstack-storage.yaml

The OpenStack Heat template file for
deploying virtual machine-based Storage
Nodes using DHCP for IP address
assignment.
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/openstack/openstack-gateway.yaml

The OpenStack Heat template file for
deploying API Gateway Nodes using DHCP
for IP address assignment.

/openstack/openstack-archive.yaml

The OpenStack Heat template file for
deploying Archive Nodes using DHCP for IP
address assignment.

/openstack/openstack-non-primaryadmin.yaml

The OpenStack Heat template file for
deploying any additional Admin Nodes in a
multi-site deployment using DHCP for IP
address assignement.

Static network deployment templates
/openstack/openstack-primaryadmin-static.yaml

The OpenStack Heat template file for
deploying the primary Admin Node using
static IP address assignment.

/openstack/openstack-storagestatic.yaml

The OpenStack Heat template file for
deploying virtual machine-based Storage
Nodes using static IP address assignment.

/openstack/openstack-gatewaystatic.yaml

The OpenStack Heat template file for
deploying API Gateway Nodes using static IP
address assignment.

/openstack/openstack-archivestatic.yaml

The OpenStack Heat template file for
deploying Archive Nodes using static IP
address assignment.

/openstack/openstack-non-primaryadmin-static.yaml

The OpenStack Heat template file for
deploying any additional Admin Nodes in a
multi-site deployment using static IP address
assignment.

Deployment scripting tools
/openstack/deploy-openstackheat.sh

A command line tool for deploying the grid
node VMs.

/openstack/deploy-openstackheat.sample.ini

deploy-openstack-heat.sh command

A sample configuration file for use with the
line tool.

Hardware requirements
Before installing StorageGRID Webscale software, verify and configure hardware so that it is ready
to support the StorageGRID Webscale system.
For information about supported servers, see the Interoperability Matrix.

NetApp Interoperability Matrix Tool
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Networking requirements
You need to verify that the networking infrastructure and configuration is in place to support your
StorageGRID Webscale system.
Network model
The following networks can be configured:
•

Grid network: Required. Used for all internal StorageGRID Webscale traffic. All hosts on the
grid network must be able to talk to all other hosts. The Grid network is required, and provides
connectivity between all nodes in the grid, across all sites and subnets.

•

Admin network: Optional. A closed network used to provide for maintenance and
administration. This is typically a private network, and it may not be routable between sites.

•

Client network: Optional. An open network used to provide access to client applications.
Enables grid nodes to communicate with any subnet reachable through the local gateway. The
Client network only becomes operational after a grid node has joined the grid.

When the Grid network is used alone, it also provides all administrative and client access. The Grid
network can consist of multiple subnets. Networks containing critical grid services such as NTP can
also be added as grid subnets. For grid nodes without Client networks configured, the Grid network
gateway is the node default gateway.
The Admin network is optional, and is available for administration and maintenance access. It allows
the Grid network to be isolated and secure, while still providing administrative access to all nodes.
Internal grid and external client traffic never flows over the admin network. An Admin network
gateway is provided to allow the admin network to span multiple subnets. The admin network
gateway is never used as the node default gateway. Typical uses of the Admin network include access
to the NMS and NFS access to Audit logs on admin nodes, and SSH access to all nodes for
maintenance and support.
The Client network provides client protocol access to the grid. It is available so that the Grid network
can be isolated and secured. Normally, only Gateway or Storage Nodes are configured with a Client
network, as they provide S3 and Swift protocol access to the grid. When a Client network is
configured, the Client network gateway is required, and becomes the node default gateway when the
grid is provisioned.
Grid network connectivity is required at installation time, such that the grid node being deployed can
communicate with primary admin node. A Grid network subnet list must be configured via the
Primary Admin UI or API when completing the installation, in order to enable static route generation
between subnets on the grid network. Admin and Client network configuration may be applied when
deploying the node, or via the Grid Management Interface or API when completing the installation.
The following table summarizes the network configuration supported.
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Network

I/F

IP/Mask

Gateway

Static routes

Default route
(0.0.0.0/0)

Grid
Network
(required)

eth0

CIDR for
static IP

The Grid network
gateway must be
configured if there
are multiple grid
subnets. This will be
used as the node
default gateway until
installation. No static
routes can be
connected to multiple
grid subnets unless
this is defined.

Static routes
generated
automatically for
all nodes to all
subnets configured
in the global Grid
Network Subnet
List.

The Grid network
Gateway IP is the
default gateway
during installation.
If a Client network
is added, then the
default gateway
switches from the
Grid network
gateway to the
Client network
gateway at
provisioning.

Admin
Network
(optional)

eth1

CIDR for
static IP
(0.0.0.0 to
disable)

The Admin network
gateway is required if
multiple admin
subnets are defined.

Static routes
generated
automatically to
each subnet
configured in the
node's Admin
Network Subnet
List.

N/A

Client
Network
(optional)

eth2

CIDR for
static IP
(0.0.0.0 to
disable)

The Client network
gateway is required if
the Client network is
configured. The
Client network
gateway becomes the
default route for the
grid node during
installation/
configuration.

N/A

Added if Client
network Gateway
IP configured

•

During installation, the Grid network must be configured so that the grid node being deployed can
communicate with the primary Admin Node, using the networking configuration specified when
the grid node virtual machine was deployed.

•

During installation, at least one NTP server must be reachable by the primary Admin Node, using
the networking configuration specified when the grid node virtual machine was deployed.

•

When completing the installation, networking configuration changes, including routing, are
applied to the primary Admin Node and affected grid nodes. Depending on the networking
changes applied, it is possible that client connectivity to the primary Admin Node may be lost due
to routing or gateway changes and may need to be re-established.

If DHCP is used to assign IP addresses automatically, the leases assigned by the DHCP server must
be permanent. Once assigned, IP addresses, subnet masks, and default gateways for a grid node can
only be changed using the IP address change procedures. For more information, see the "Configuring
IP addresses" section in the Maintenance Guide for OpenStack Deployments.
Note: You can only set up DHCP during the deployment phase using the automated deployment

scripts. There are no options to set up DHCP using the Grid Management Interface or API during
installation.
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Network installation and provisioning
Nodes are initially deployed on the Grid network. It is required that all nodes be attached to the Grid
network and have access to the primary Admin Node when first deployed. If the grid network is
isolated, the Admin network can be configured on the primary Admin Node for installation and
configuration access from outside the Grid network. If the Grid network has a gateway configured, it
is the default gateway for the node when initially deployed. This allows grid nodes on separate
subnets to communicate with the primary Admin Node prior to installation.
Once the nodes have been deployed, the nodes register themselves with the primary Admin Node
using the Grid network. The Grid Management Interface or API is then used to configure the grid and
approve the registered nodes. During grid configuration, multiple grid subnets can be configured.
Static routes to these subnets through the Grid network gateway will be created on each node during
installation. If necessary, subnets containing NTP servers or requiring access to the Grid
Management Interface or API can also be configured as grid subnets.
During the node approval process, nodes may be configured with Admin and Client networks as
desired. Nodes configured with a client network will have the default gateway for the node switched
from the grid network to the client network during installation.
Note: Care must be taken when configuring a Client network. If access to the Grid Management

Interface or API, or access to NTP servers, is provided over the Grid network gateway, it could be
lost when the node default gateway is switched to the Client network. Access to the Grid
Management Interface/API, NMS and NTP servers should be added as Grid networks or provided
via the Admin network when the Client nework is used.
Network

Behavior

If you are creating
a Grid network
only…

All Grid, Admin and Client network traffic
flows over the grid network. The Grid
network gateway is the node default
gateway.

If you are creating
a Grid network and
an Admin
network…

Grid and Client network traffic flows over
the Grid network. Administrative traffic
flows over the Admin network. The Grid
network gateway is the node default
gateway

If you are creating
a Grid network and
Client network (no
Admin)…

At installation, the Grid network gateway is
the node default gateway. Subnets
providing access to the Grid Management
Interface/API and NTP servers should be
included as Grid networks during
configuration. During installation, the
Client network gateway becomes the node
default gateway.

Recommended Configuration

NTP and installer client access
must be possible through both
the Grid and Client network
gateways.
OR
Add the NTP and/or installer
client subnets as Grid
networks.
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If you are creating
a Grid network,
Admin network,
and Client
network…

At installation, the Grid network gateway is
the node default gateway. Subnets
providing access to the Grid Management
Interface/API and NTP servers should be
included as grid networks or as admin
subnets during configuration. During
installation, the Client network gateway
becomes the node default gateway.

NTP and installer client access
must be possible through both
the Grid and Client network
gateways.
OR
Add the NTP and/or installer
client subnets as Grid networks
(so explicit routes will be
created).
OR
NTP and installer client
subnets can be added to the
Admin network explicit route
list (ESL).

If you are planning
on adding a Client
network at a later
time…

Subnets providing access to the Grid
Management Interface/API and NTP
servers should be included as Grid
networks or as admin subnets. The Client
network gateway will become the node
default gateway

NTP and installer client access
must be possible through both
the Grid and Client network
gateways.
OR
Add the NTP and/or installer
client subnets as Grid networks
(so explicit routes will be
created).
OR
NTP and installer client
subnets can be added to the
Admin network ESL.

Additional information on networking configuration and supported network topologies can be found
in the Grid Primer.
Deployment tools
The deployment tools are part of the process of deploying grid nodes and then configuring the
network for the StorageGRID Webscale system:
•

If you are manually performing deployment and installation, you use a .vmdk file to create the
grid node types and a set of .Heat file templates to deploy virtual grid nodes. You use command
line operations to deploy these tools, and then you use the Grid Management Interface to
configure the network.

•

If you are automatically performing deployment and installation, you use the deployment tool to
install and configure virtual grid nodes. The deployment tool uses the .vmdk file and the Heat
template files as source files for the operation. You provide arguments for the deployment tool to
use during configuration. The deployment tool uses an INI file as a sample configuration file you
can modify for configuration.

If you are using the automated deployment scripts, the deploy-openstack-heat.sh script will
create the required Admin network and Client network ports where DHCP or STATIC is selected for
the network, rather than DISABLED:
•

When the Client or Admin network configuration parameter is set to DHCP, a port for that
network is added to the HEAT .yaml file.
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•

When the Client network or Admin network is set to STATIC, a port with a fixed IP address for
that network is added to the HEAT .yaml file.
Note: If you want to set up DHCP, you must use the non-static .yaml deployment template

during the deployment phase. There are no options to set up DHCP later using the Grid
Management Interface or API during the installation phase.
If you are manually deploying your grid, you need to create and attach the ports for any grid nodes
that will have the Admin network or Client network configured. This configuration must be
completed using the OpenStack command line tools, as shown in the following example:
1. Create the required port.
neutron port-create --name name --fixed-ip
subnet_id=subnet_id,ip_address=ip_address network_name_or_id

2. Attach the port to the interface.
nova interface-attach --port-id port_id VM_name_or_ID

The port ID used in this command will be shown upon successful creation of the port, e.g., from the
previous command. It can also be seen using
neutron port-list

.
Important: It is critical that the IP address provided when creating the port match the IP address

configured when the node was deployed, for the given network.
For more information on using the OpenStack command line tools, see docs.openstack.org.
After grid nodes are created during deployment, the Grid Management Interface or API can be used.
Additional information on networking configuration and supported network topologies can be found
in the Grid Primer.
Internal grid node communications
The ports listed in the table below must be accessible to grid nodes on the Grid network. Ensure that
the required ports for the grid node type are open on the server.
Note: Configuration of the following ports is only required if you need to define firewall

restrictions that are external to OpenStack networking.
Port

Description

Grid node type

22 (TCP)

SSH

All

123 (UDP)

NTP

All

443 (TCP)

HTTPS

Admin Nodes

1139 (TCP)

LDR replication

Storage Nodes

1501 (TCP)

ADC service connection

Storage Nodes

1502 (TCP)

LDR service connection

Storage Nodes

1503 (TCP)

CMS service connection

Storage Nodes

1504 (TCP)

NMS service connection

Admin Nodes

1505 (TCP)

AMS service connection

Admin Nodes

1506 (TCP)

SSM service connection

All grid node types

1507 (TCP)

CLB service connection

API Gateway Nodes
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Port

Description

Grid node type

1508 (TCP)

CMN service connection

Admin Nodes

1509 (TCP)

ARC service connection

Archive Nodes

1511 (TCP)

DDS service connection

Storage Nodes

2022 (TCP)

SSH can optionally be
configured on this port if 22 is
unavailable.

All

5353 (UDP)

mDNS optionally used for
primary Admin Node
discovery during installation
and expansion

All

7001 (TCP)

Cassandra SSL inter-node
cluster communication

Storage Nodes

9042 (TCP)

Cassandra CQL Native
Transport Port

Storage Nodes

80 (TCP)

Used by StorageGRID
Webscale appliance Storage
Nodes (with firmware prior to
version 1.5) to communicate
with the primary Admin Node
to start the installation

SGA Storage Nodes

11139 (TCP)

ARC replication

Archive Nodes

18000 (HTTPS)

Account service connection

Storage Nodes

18001 (HTTPS)

Identity service connection

Storage Nodes

18002 (TCP)

Internal HTTP API services

Storage Nodes

18080 (TCP)

CDMI

Storage Nodes

External client communications
Clients need to communicate with grid nodes and by extension the servers that host them in order to
ingest and retrieve content. The port differs depending on the protocols chosen to ingest and retrieve
content.
Port

Description

Connection to

22 (TCP)

ssh

Servers being used as an
access point into the system for
software installation and
maintenance

80 (TCP)

HTTP

Admin Nodes (redirects to
443)

161 (TCP/UDP)

snmp

Servers that are being
monitored through SNMP

162 (TCP/UDP)

snmptrap

Servers that are being
monitored through SNMP

389 (TCP/UDP)

LDAP

Storage Nodes (ADC service)
to LDAP server
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Port

Description

Connection to

443 (TCP)

HTTPS

Admin Nodes

445 (TCP)

SMB

Audit log access on Admin
Nodes

905 (TCP)

NFS statd

Audit log access on Admin
Nodes

2049 (TCP)

NFS

Audit log access on Admin
Nodes

8080 (TCP)

CDMI

API Gateway Nodes

8082 (TCP)

S3

API Gateway Nodes

8083 (TCP)

Swift

API Gateway Nodes

18080 (TCP)

CDMI

Storage Nodes

18082 (TCP)

S3

Storage Nodes

18083 (TCP)

Swift

Storage Nodes

Storage requirements
You must ensure that each Storage Node has enough space to support the initial configuration and
future storage expansion.
Storage Nodes must be provisioned with the appropriate amount of storage space on the first storage
volume (rangedb0) to ensure that the Cassandra database has enough space for the initial
configuration of the Storage Node and any future storage expansion through the addition of storage
volumes (LUNs). The minimum size for rangedb0 is 4 TB.

Web browser requirements
You need to access the StorageGRID Webscale system using a supported web browser.
Web browser

Minimum supported version

Google Chrome

43

Microsoft Internet Explorer

11

Mozilla Firefox

38.0.5

You should set the browser window to a recommended width.
Browser width

Pixels

Minimum

1024

Optimum

1280 or larger
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Performing the installation
Installing your StorageGRID Webscale system involves deploying grid nodes in OpenStack
Dashboard and then configuring your grid and installing StorageGRID Webscale software using the
installation web UI on the primary Admin Node to complete the installation.

Uploading a Glance image
Glance images are templates for virtual machine file systems. You need to create a Glance image that
provides a template for creating StorageGRID Webscale grid nodes.
Before you begin

You must have the .vmdk file. You can specify the .vmdk file to upload using a URL accessible from
the OpenStack Glance server, or you can use a file accessible from a machine running the web
browser, such as the service laptop.
Steps

1. Sign in to the OpenStack Dashboard.
2. Select Project > Compute > Images.
3. Click Create Image.
4. In the Create An Image dialog box, enter the image details:
•

Name: Specify a descriptive name for the root image, for example, the release version string,
for example, NetApp-SG-Version-SHA.

•

Description: Enter descriptive information to assist in identifying the purpose of the image,
for example, StorageGRID Webscale 10.3.

•

Image Source: Choose one of the following:

•

◦

If you are using a URL to access the .vmdk file: Select “Image Location”.

◦

If you are uploading the .vmdk file from the console connection running the web
browser: Select “Image File”.

Image Location: Choose one of the following:
◦

If you are using a URL to access the .vmdk file: Specify the URL where the virtual
machine disk file (.vmdk) is located, for example, http://openstack.example.com/
uploads/NetApp-SG-Version-SHA.vmdk.

◦

If you are uploading the .vmdk file from the console connection running the web
browser: Click the “Choose File” button.

•

Format: Select “VMDK - Virtual Machine Disk”.

•

Architecture: Leave this field blank. You do not need to specify a value.

•

Minimum Disk (GB): Specify a minimum disk size of 100.

•

Minimum RAM (MB): Leave this value empty to accept the default value (0), which
specifies no minimum RAM value.
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•

Copy Data: Ensure that this checkbox is selected.

5. Click Create Image.
Wait until the status of the image goes from “Saving” to “Active” before continuing.

Creating a security group
You need to create a security group with the appropriate IP filter rules to enable access to grid nodes
in your StorageGRID Webscale system.
About this task

The recommended security group allows all traffic on all ports for all protocols. This is because each
grid node is protected by its own internal firewall.
Note: You can alternatively use the /openstack/security_group.yaml template file included
in the StorageGRID Webscale download file (.tgz) to create the required security group entry.
Steps

1. Sign in to the OpenStack Dashboard.
2. Select Project > Compute > Access & Security.
3. Click the Security Groups tab.
4. Click Create Security Group.
5. Enter a descriptive name, and optionally, a description.
6. Click Create Security Group.
7. Click Manage Rules for the new security group.
8. Ensure a rule exists with the following settings:
•

Direction: Egress

•

Ether Type: IPv4

•

IP Protocol: Any

•

Port Range: Any

•

Remote IP Prefix: 0.0.0.0/0

9. Click Add Rule.
10. In the Add Rule dialog box configure the firewall rule:
•

Rule: Select “ALL TCP” from the drop-down list.

•

Rule: Select “ALL UDP” from the drop-down list.

•

Rule: Select “ALL ICMP” from the drop-down list.

•

Direction: Select “Ingress”.

•

Remote: Select “CIDR” from the drop-down list.

•

CIDR: Specify 0.0.0.0/0

11. Click Add.
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Creating a Nova flavor
An OpenStack Nova flavor is a virtual hardware template. You must create a flavor to customize the
hardware profile used to create grid nodes, so that you can have precise control over the resources
used.
Before you begin

You must have Administrator rights to the OpenStack installation to create a Nova flavor. If you do
not have Administrator rights, you must have an administrator create the required flavor.
About this task
Note: You must create a new flavor or use an existing flavor that meets or exceeds the values used
below. Another alternative is to use the /openstack/flavor.yaml template file included in the
StorageGRID Webscale download file (.tgz) to create the Nova flavor entry.
Note: Using the flavor YAML template may require the installation of a Heat template patch, and

this requires OpenStack admin access. You might have to request the flavor be created by an admin
if you are installing as a tenant user.
Steps

1. Sign in to the OpenStack Dashboard.
2. Select Admin > Flavors.
3. Click Create Flavor.
4. In the Create Flavor dialog box, enter the flavor details:
•

Name: Specify a descriptive name for the flavor.

•

ID: Ensure that “auto” is specified.

•

VCPUs: Specify the appropriate number of virtual CPUs for your deployment. The
recommended minimum for production systems is 8vCPUs.

•

RAM (MB): Specify the appropriate amount of RAM for your deployment. The
recommended minimum for production systems is 24GB RAM.

•

Root Disk (GB): Specify 0.

•

Ephemeral Disk (GB): Specify 0.

•

Swap Disk (MB): Specify 0.

5. Click Create Flavor.
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Deploying virtual machine grid nodes in OpenStack
Dashboard
You must deploy the grid nodes that make up your StorageGRID Webscale system. Once the grid
nodes are deployed, you can you can use the installation web page on the primary Admin Node to
configure the grid nodes.
Before you begin

•

You must already be familiar with OpenStack Dashboard, and have experience deploying virtual
machines in this environment.

•

You must have selected the required templates for the grid nodes you need to deploy.

•

You must already be familiar with the network environment you are deploying to, and whether
you will use DHCP for IP address assignment, or use STATIC IP address assignment. There are
separate templates for DHCP and static IP addressing.

•

You can specify the Heat .yaml template files to upload using a URL accessible from the
OpenStack Glance server, or as a file accessible from the service laptop (any location where the
web browser is running).

Steps

1. Sign in to the OpenStack Dashboard.
2. Select Project > Orchestration > Stacks.
3. Click Launch Stack.
4. In the Select Template dialog box enter the configuration information for the grid node stack:
•

Template Source: Select “URL” from the drop-down list.

•

Template URL: Enter, or copy and paste, the location of the grid node Heat template, for
example: https://openstack.example.com/openstack-primary-admin.yaml

5. Click Next.
6. In the Launch Stack dialog box, enter the stack deployment information. The required
information depends on the type of grid node you are deploying and the networking environment
you are deploying to.
•

Stack Name: Enter a meaningful name for the stack, for example: DC1-ADM1 for the
primary Admin Node.

•

Creation Timeout (minutes): The time to allow for the stack creation before a timeout in
minutes.

•

Rollback On Failure: Select this option to enable rollback to the starting state upon failure.
This option should be selected with caution, because it will prevent error messages from being
displayed in OpenStack Dashboard if the deployment fails.

•

Password for user "username": Enter the password for the specified OpenStack user
account.

•

Node name: Specify the name of the virtual machine, which is typically the name of the grid
node. It is a best practice to assign the grid node name the VM during the initial virtual
machine deployment.
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•

Root disk image: Select the root image you uploaded to Glance for your StorageGRID
Webscale deployment.

•

Range DB Disk Size: For Storage Nodes, specify the size of each of the three rangeDBs, or
storage volumes, to create on the Storage Node.

•

Nova instance flavor: Select the flavor you created for your StorageGRID Webscale
deployment or an equivalent existing flavor.

•

Primary Admin IP Address: For all grid nodes except the primary Admin Node, enter the IP
address defined for the primary Admin Node. If you omit the primary Admin Node IP
address, the IP address will be automatically discovered for grid nodes in the same subnet as
the Primary Admin Node, or on subnets with at least one node with ADMIN_IP configured
present.

7. You must configure the Grid Network under the Grid Network Parameters section. Select one
of the following from the Grid Network Configuration field:
•

DHCP

•

Static

8. If you use the STATIC deployment templates, you must specify the following for each grid node
under the Grid Network section.
a. Enter the Grid Network node IP address.
b. Enter the Grid Network node network mask.
c. Enter the Grid Network node gateway.
9. If you are going to use the Admin Network, configure the Admin Network under the Admin
Network Parameters section. Select one of the following from the Admin Network
Configuration field:
•

DHCP

•

Static

•

Disabled

10. If you are configuring the Admin Network, deploy the primary Admin Node for the Admin
Network in the next step, and enter the following under the Admin Network Parameters section.
If you are not using the Admin Network, then you can select the same network chosen for the
Grid Network.
a. Enter the Admin Network node IP address.
b. Enter the Admin Network node network mask.
c. Enter the Admin Network node gateway.
11. If you are deploying the primary Admin Node on the Admin Network, enter the primary Admin
Node IP address in the field. If you do not want to configure an Admin Network, leave the value
of the Admin Network configuration drop-down list as DISABLED, and leave the other fields at
their default values. Optionally, you can select STATIC and enter the network information to use
static IP address allocation. Select DHCP to use dynamic host allocation. In the Admin Network
Static Routes text box, enter a comma separated list of static routes to enable.
12. Select a value for the Client Network. If you are not using the Client Network, then you can select
the same network chosen for the Grid Network.
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13. If you are going to use the Client Network, configure the Client Network under the Client
Network Parameters section. Select one of the following from the Client Network
Configuration field:
•

DHCP

•

Static

•

Disabled

14. If you are configuring the Client Network, deploy the nodes for the Client Network by entering
the following:
a. Enter the Client Network node IP address.
b. Enter the Client Network node network mask.
c. Enter the Client Network node gateway.
15. If you are deploying the primary Admin Node, select the Client Network to use. If you do not
want to configure a Client network, leave the value of the Client Network configuration dropdown list as DISABLED, and leave the other fields at their default values. Optionally, you can
select STATIC and enter the network information to use static IP address allocation. Select DHCP
to use dynamic host allocation. You do not need to specify an IP address for DHCP, and any value
entered will not be used.
16. Click Launch.

Adding storage volumes to Storage Nodes
You can add up to 16 storage volumes to each Storage Node to maximize the storage capacity.
About this task

Three storage volumes, of the specified size, are attached to each Storage Node when it is deployed.
You only need to add storage volumes if you want to attach additional storage to the Storage Node.
To increase the total usable storage capacity of the system, you must generally add storage capacity
to more than one Storage Node.
Steps

1. Sign in to the appropriate tenant and project in OpenStack Dashboard.
2. Select Project > Compute > Volumes.
3. Click Create Volume.
4. Add one or more hard disks to the virtual machine for use as storage (rangedbs):
a. In the Create Volume dialog box, enter the volume details:
•

Volume Name: Enter a new name for the storage volume that follows the naming
convention for existing storage volumes, for example, DC1-S1 RangeDB4.

•

Description: Enter a meaningful description for the expansion storage volume, for
example, StorageGRID Node DC1-S1 RangeDB 4.

•

Volume Source: Select “No source, empty volume” from the drop-down list.

•

Type: Select “No volume type” from the drop-down list.

•

Size (GB): Enter the appropriate size for the storage volume (rangeDB) in gigabytes.
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•

Availability Zone: If Availability Zones are used by your StorageGRID Webscale system,
select the appropriate zone, otherwise, select “Any Availability Zone” from the drop-down
list.

b. Click Create Volume.
The storage volume is created and the new entry is added to the Volumes table.
5. In the Actions column for the new storage volume, select “Manage Attachments” from the dropdown list.
6. In the Manage Volume Attachments dialog box, select the grid node instance to attach the
storage volume to from the drop-down list.
7. Click Attach Volume.
The storage volume is attached the grid node virtual machine.

Deploying StorageGRID Webscale appliance Storage Nodes
When you deploy a StorageGRID Webscale appliance, you install it as a Storage Node. You might
have multiple appliance Storage Nodes, multiple Storage Nodes hosted by virtual machines, or a
combination of both. Deploying the appliance enables you to monitor it in the StorageGRID
Webscale grid.
Before you begin

You must have already deployed the primary Admin Node.
About this task

Deploying a Storage Node appliance involves several major tasks.
If your grid includes grid nodes deployed on virtual machines, you can deploy them before or after
deploying a Storage Node appliance.
Steps

1. Connecting to the StorageGRID Webscale Appliance Installer on page 23
To start the appliance software installation, connect to the StorageGRID Webscale Appliance
Installer. The installer enables you to configure the management network, configure the data
network connection, enter the primary Admin Node IP address if necessary, and monitor the
installation progress.
2. Configuring network connections on page 24
Using the StorageGRID Webscale Appliance Installer, enter the networking information for the
Storage Node.
3. Setting the primary Admin Node IP address on page 26
You can use the StorageGRID Webscale Appliance Installer to set the IP address of the primary
Admin Node if necessary. Setting this enables installer connectivity.
4. Installing and monitoring StorageGRID Webscale software installation to complete on the
appliance on page 27
The StorageGRID Webscale Appliance Installer provides status until the StorageGRID Webscale
software installation is complete. Next, "Convert installation to bare-metal" starts. After this is
finished, the appliance reboots itself.

Performing the installation | 23

Connecting to the StorageGRID Webscale Appliance Installer
To start the appliance software installation, connect to the StorageGRID Webscale Appliance
Installer. The installer enables you to configure the management network, configure the data network
connection, enter the primary Admin Node IP address if necessary, and monitor the installation
progress.
Steps

1. Open a browser and enter the E5600SG controller Management Port 1 IP address that was
provisioned during the physical installation. This address may be available on the seven-digit
display if the appliance has been configured to display the IP.
http://Management_Port_IP:8080

The StorageGRID Webscale Appliance Installer Home page appears:

Note: This example shows the 1.5 version of the StorageGRID Webscale Appliance Installer.
The 1.3 version of this page has a different appearance, does not list the version in the header,
and does not support Client network configuration.

When you are first installing the appliance, the status for each procedure indicates that the
procedure is not complete.
2. Verify the status of these items:
a. Configure Admin network. This is the Admin network that was specified using the
hypervisor deployment tools. If you choose to set or reset this option, you will configure this
network in the upcoming task titled "Configuring network connections."
b. Configure Grid network. This is the Grid network that was specified using the hypervisor
deployment tools. If you choose to set or reset this option, you will configure this network in
the upcoming task titled "Configuring network connections."
c. Set StorageGRID Installer IP. This is the primary Admin Node IP address that was
specified using the hypervisor deployment tools. If you choose to set or reset this option, you
will configure this IP address in the upcoming task titled "Setting the primary Admin Node IP
Address."
Note: The Installer detects and populates node data on this screen if the grid is a 10.3 grid.

However, if the grid is a 10.2 grid, then the error message "The StorageGRID Installer does not
have a configuration for the Grid network IP" displays.
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Configuring network connections
Using the StorageGRID Webscale Appliance Installer, enter the networking information for the
Storage Node.
Before you begin

You must already have the IP address of the Grid network if you are using static IP address
assignment.
Steps

1. On the StorageGRID Webscale Appliance Installer, click Configure Network Connections.
Note: This example shows the 1.5 version of the StorageGRID Webscale Appliance Installer.
The 1.3 version of this page has a different appearance, does not list the version in the header,
and does not support Client network configuration.
There are three networks you can configure. The Grid network and Admin network are required.
The Client network is optional.
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Use the Admin network interface to connect to the installer on the appliance.
The Grid network connection is used for communications between the appliance and the
installation API on the primary Admin Node during installation, and this interface provides
connectivity to your grid when the appliance installation is complete. The optional Client network
enables client applications to communicate with the Storage Node after installation is complete.
2. If you are using static IP address allocation, complete the following steps for each of the networks
you are configuring:
a. Click Change Static IP/netmask.
The button name changes to Save Changes and a pop-up appears.
b. Enter the IP address for the network and click Save Changes.
Route information based on the specified IP displays.
c. In the pop-up, click OK.
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d. If needed, edit the route and click Save route.
The default route must be configured on the network connection interface.
3. If you are using DHCP for IP address allocation, click Use DHCP for IP/Netmask.
4. Click Test next to the Ping IP on network text box to verify that the IP address is reachable.
5. Click OK to acknowledge the ping message. The following message displays for a failed ping:
PING OF “10.223.0.1” FAILED.
PING 10.223.0.1 (10.223.0.1) from 10.224.1.92 br1: 56(84) bytes of
data.
--- 10.223.0.1 ping statistics --1 packets transmitted, 0 received, 100% packet loss, time 0ms

The following message displays for a successful ping:
PING OF “10.223.0.1” SUCCESSFUL.
PING 10.224.1.196 (10.224.1.196) from 10.224.1.92 br1: 56(84) bytes
of data.
64 bytes from 10.224.1.196: icmp_req=1 ttl=64 time=0.433 ms
--- 10.224.1.196 ping statistics --1 packets transmitted, 1 received, 0% packet loss, time 0ms
rrt min/avg/max/mdev = 0.433/0.433/0.433/0.000 ms

Setting the primary Admin Node IP address
You can use the StorageGRID Webscale Appliance Installer to set the IP address of the primary
Admin Node if necessary. Setting this enables installer connectivity.
Before you begin

Verify that the IP address of the primary Admin Node is correct. As with other node types, this
requires the primary Admin Node, or at least one other node with ADMIN_IP configured, to exist on
the same subnet as the appliance.
Steps

1. Click Home to navigate to the main StorageGRID Webscale Appliance Installer.
2. The Installer IP is the primary Admin Node IP address that was configured during deployment of
the virtual nodes. Use this field to verify or reset the IP address as needed. In the StorageGRID
Installer IP text box, enter the IP address of the primary Admin Node and click Update.
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The Installer IP address will be automatically discovered if the primary Admin Node, or at least
one other grid node with ADMIN_IP configured, is present on the same subnet. If the IP address
in the field was automatically populated, a status of “(discovered)” displays next to the field as
shown in this example:

The primary Admin Node IP address is specified in the initial node deployment steps. If the
primary Admin Node IP address was not deployed or should be changed, use this field to accept
or update the IP address.
3. Click OK in the confirmation dialog box.
4. The Node Name is detected and populated by the system if the Node Name was provided during
deployment. Use this field to verify or reset the Node Name as needed. In the StorageGRID
Node Name text box, enter the name of the Storage Node and click Update.
This name will be pre-populated in the StorageGRID Webscale Grid Management Interface grid
node approval page, and the name is assigned to the Storage Node in the StorageGRID Webscale
system.

Installing and monitoring StorageGRID Webscale software installation to
complete on the appliance
The StorageGRID Webscale Appliance Installer provides status until the StorageGRID Webscale
software installation is complete. Next, "Convert installation to bare-metal" starts. After this is
finished, the appliance reboots itself.
Before you begin

You must have already entered the network configuration information and entered the primary Admin
Node IP address.
Steps

1. From the StorageGRID Webscale Appliance Installer, next to the Set StorageGRID Webscale
Installer IP option, click Begin StorageGRID node install node_name:

A list of install operations appears. You can review the installation progress as each operation
status changes from “Not started” to “Completed.” The status refreshes every five seconds.
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Note: The Installer ensures that certain tasks accomplished in a previous install that do not
need to be done are not re-executed. On the progress page, tasks that do not require reexecution remain in a “Not started” state.

2. To monitor progress, return to the StorageGRID Webscale Appliance Installer.
The Deploy Grid Nodes section shows the installation progress for the Storage Node appliance.
3. Review the installer.
The following occurs:
•

When the operating system is being installed, a thumbnail image of the installation screen
appears next to the list of operations.

•

The StorageGRID Webscale Installer Deploy Grid Nodes status bar changes to blue,
indicating a job in progress, and then to green, indicating successful completion.

•

The installer shows the last 10 lines of the installation log, which updates every five seconds.

•

For new installations, after the last operation, “Boot into StorageGRID” is displayed on the
last line, indicating a status of initiating the reboot.
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4. Repeat this process for any additional appliances.
After you finish

The deployment stops while awaiting the node-specific configuration. The system does not
automatically continue the deployment. You must proceed to the next task to trigger it.

Navigating to the Grid Management Interface
You use the Grid Management Interface to define all of the information required to configure your
StorageGRID Webscale system on each grid node.
Before you begin

The primary Admin Node virtual machine must be deployed and have completed the initial startup
sequence.
Steps

1. Open your web browser and navigate to https://primary_admin_node_ip
Note: This might be the Grid network IP or the Admin network IP, as appropriate for your
network configuration.

2. Click Install a StorageGRID Webscale system.
The Grid Management Interface displays in setup mode for the installation.
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Specifying the StorageGRID Webscale license information
You need to specify the name for your StorageGRID Webscale system and upload the license file
provided by NetApp.
Steps

1. In the License page, enter a meaningful name for your StorageGRID Webscale system in Grid
Name.
The name is displayed as the top level in the grid topology tree after installation.
2. Click Browse, locate the NetApp License File (NLFunique_id.txt) and click Open.
The license file is validated and the serial number and licensed storage capacity are displayed on
screen.
Note: A non-production license (NLF00000.txt) is provided and can be used for testing and
proof of concept grids. You may update to a production license after installation.

3. Click Next.
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Adding sites
You need to create at least one site when you are installing your StorageGRID Webscale system. You
can create additional sites to increase the reliability and storage capacity of your StorageGRID
Webscale grid.
Steps

1. In the Sites page, enter the Site Name.
2. To add additional sites, click the plus sign next to the last site entry and enter the name in the new
Site Name text box.
Add as many additional sites as required for your grid topology. You can add up to 16 sites.

3. Click Next.

Specifying grid networks
You need to specify the subnets that are used on the Grid Network. These entries typically include
the subnets for the Grid Network for each site in your StorageGRID Webscale system, along with any
subnets that need to be reachable via the Grid Network (for example NTP servers).
About this task

Additionally, if you have multiple grid subnets, then the grid network gateway is required.
Steps

1. Specify the CIDR network address for at least one Grid Network in the Network 1 text box.
2. Click the plus sign next the last entry to add an additional network entry.

32 | StorageGRID Webscale 10.3 Installation Guide for OpenStack Deployments

3. Click Next.

Configuring grid nodes
You need to approve and configure grid nodes so that they are added correctly to your StorageGRID
Webscale system.
Steps

1. Approving pending grid nodes on page 32
You need to approve each grid node before it joins your StorageGRID Webscale grid, so that you
are able to ensure that the necessary infrastructure is in place.
2. Modifying approved grid node properties on page 35
You can modify the properties of approved grid nodes and make any changes required to finalize
your node configurations so that your installation environment matches the physical environment
into which you are deploying your grid.

Approving pending grid nodes
You need to approve each grid node before it joins your StorageGRID Webscale grid, so that you are
able to ensure that the necessary infrastructure is in place.
Steps

1. Select the radio button next to the entry you want to approve in the Pending Nodes list.
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2. Click Approve.
3. In General Settings, modify settings for the following properties, as necessary:

•

Site Name: The name of the site the grid node will be associated with.
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•

Name: The name that will be displayed in the StorageGRID Webscale user interface.

•

NTP Role: The grid node's Network Time Protocol (NTP) role. The options are Automatic,
Primary, and Client. Automatic assigns the Primary option to Admin Nodes and Storage
Nodes with ADC, and the Client option to all other grid node types.

•

ADC Service: For Storage Nodes, this option determines whether the selected node will run
the Administrative Domain Controller service. Select "Automatic" to have the this option
applied automatically by the system as required, or select "Yes" or "No" to explicitly set this
option for the grid node. For example, you might need to select Yes if you want to have more
than 3 ADC services at a site.

4. In Grid Network, modify settings for the following properties as necessary:
•

IPv4 Address (CIDR): The CIDR network address for the eth0 grid network interface. For
example: 192.168.0.0/21

•

Gateway: The default gateway of the grid node. For example: 192.168.0.1
Note: The gateway is required if there are multiple grid subnets.

5. If you want to configure the Admin Network for the grid node, add or update the settings in the
Admin Network section as necessary.
Enter the destination subnetworks of the routes out of this interface in the Subnets (CIDR) text
box. If there are multiple admin subnets, the admin gateway is required.
6. If you want to configure the Client Network for the grid node, add or update the settings in the
Client Network section as necessary. If the Client network is configured, the gateway is required,
and it becomes the default gateway for the node during installation.
7. Click Save.
The approved grid node entry moves to the Approved Nodes list.

8. Click Next.
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Modifying approved grid node properties
You can modify the properties of approved grid nodes and make any changes required to finalize
your node configurations so that your installation environment matches the physical environment into
which you are deploying your grid.
Steps

1. Select the radio button next to the entry you want to edit in the Approved Nodes list.
2. Click Edit.
The Grid Node Configuration page is displayed.
3. In General Settings, modify settings for the following properties, as necessary:
•

Site Name: The name of the site the grid node will be associated with.

•

Name: The name that will be displayed in the StorageGRID Webscale user interface.

•

NTP Role: The grid node's Network Time Protocol (NTP) role. The options are Automatic,
Primary, and Client. Automatic assigns the Primary option to Admin Nodes and Storage
Nodes with ADC, and the Client option to all other grid node types.

•

ADC Service: For Storage Nodes, this option determines whether the selected node will run
the Administrative Domain Controller service. Select "Automatic" to have this option applied
automatically by the system as required, or select "Yes" or "No" to explicitly set this option
for the grid node. For example, you might need to select Yes if you want to have more than 3
ADC services at a site.

4. In Grid Network, modify settings for the following properties as necessary:
•

IPv4 Address (CIDR): The CIDR network address for the eth0 grid network interface. For
example: 192.168.0.0/21

•

Gateway: The default gateway of the grid node. For example: 192.168.0.1

5. Click Save.
6. Repeat the preceding steps for each grid node you must approve.
7. Click Next.

Specifying Network Time Protocol server information
You must specify the Network Time Protocol (NTP) configuration information for the StorageGRID
Webscale system, so that operations performed on separate servers can be kept in sync.
About this task

You must specify external NTP servers. The specified NTP servers must use the NTP protocol. The
SNTP protocol, used by the Windows Time Service in particular, is not supported.
You must specify four NTP server references of Stratum 3 or better to prevent issues with time drift.
Steps

1. Specify the IP addresses for at least four NTP servers in the Server 1 to Server 4 text boxes.
2. If necessary, click the plus sign next the last entry to add additional server entries.
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3. Click Next.

Specifying Domain Name System server information
You need to specify Domain Name System (DNS) information for your StorageGRID Webscale
system to access external servers using hostnames instead of IP addresses.
About this task

Specifying DNS server information allows you to use Fully Qualified Domain Name (FQDN)
hostnames rather than IP addresses. This affects email notifications, AutoSupport, and server
connectivity.
If the DNS server information is omitted or incorrectly configured, a DNST alarm is triggered on
each grid node’s SSM service. When DNS is configured correctly, and the new server information
reaches all grid nodes, the alarm clears.
Steps

1. Specify the IP address for at least one DNS server in the Server 1 text box.
2. If necessary, click the plus sign next to the last entry to add additional server entries.

3. Click Next.
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Specifying the StorageGRID Webscale system passwords
You need to enter the passwords to use to secure your StorageGRID Webscale system.
Steps

1. In Provisioning Passphrase, enter the provisioning passphase that will be required to make
changes to the grid topology of your StorageGRID Webscale system. You should record this
password in a secure place.
2. In Confirm Provisioning Passphrase, reenter the provisioning passphrase to confirm it.
3. In Grid Management Root User Password, enter the password to use to access the Grid
Management Interface as the “root” user.
4. In Confirm Root User Password, reenter the Grid Management password to confirm it.

5. For production deployments random passwords should always be used for security reasons. If you
are installing a grid for proof of concept or demo purposes, you can deselect the Create random
command line passwords to use default passwords for accessing grid nodes from the command
line using the “root” account.
Important: You must download the Recovery Package file (sgws-recovery-package-idrevision.zip) in order to complete the installation. You will be prompted to download the

file after you click Install on the summary Summary page. The passwords required to access
the system are stored in the Passwords.txt file.
6. Click Next.
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Reviewing your configuration and installing the
StorageGRID Webscale system
You must carefully review the configuration information you have entered to ensure that your
StorageGRID Webscale system installation completes successfully.
Steps

1. View the Summary page.

2. Verify that all of the grid configuration information is correct. Use the Modify links on the
Summary page to go back and correct any errors.
3. Click Install.
When the installation progresses to the point where the grid topology is defined, you will be
prompted to download the Recovery Package file (.zip), and confirm that you can successfully
access the contents of this file. You must download the Recovery Package file so that you can
recover the StorageGRID Webscale system in the event that one or more grid nodes fails. The
installation continues in the background, but you cannot complete the installation and access the
StorageGRID Webscale system until you download and verify this file.
4. Click Download the Recovery Package.
5. Verify that you can extract the contents of the .zip file, and then save it in two safe, secure, and
separate locations.
Important: The Recovery Package file must be secured because it contains encryption keys and
passwords that can be used to obtain data from the StorageGRID Webscale system.

6. Select the I have successfully downloaded and verified the Recovery Package file checkbox,
and click Next.
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If the installation is still in progress, the status page is displayed indicating the progress of the
installation for each grid node.

Once the installation status for all grid nodes reaches 100%, the installation is complete, and the
login page for the Grid Mangement Interface is displayed.
7. Log in to the Grid Management Interface for the first time using the "root" user and the password
you specified during the installation.
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Where to go next
After completing an installation, you must perform a series of integration and configuration steps.
Some steps are required; others are optional.
Required tasks
•

Configure the StorageGRID Webscale system’s information lifecycle management (ILM) policy.
For information on defining and setting up an appropriate ILM policy, see “Understanding
information lifecycle management” and “Configuring information lifecycle management” in the
Administrator Guide.

•

Configure the Domain Name Service (DNS).
You have two options for configuring DNS. If you want to update configuration DNS settings for
all grid nodes, see the “Configuring DNS Servers” section in the Maintenance Guide. If you want
to configure the DNS settings separately for each individual grid node, see the “Modifying the
DNS Configuration for a single grid node” section in the Administrator Guide.

•

Create accounts for users and administrators.
You need to set up accounts with the appropriate permissions for any other users that will access
the system. For more information, see “Managing Accounts” in the Administrator Guide.

•

Configure Archive Node
If your StorageGRID Webscale system includes any Archive Nodes, you must configure the
Archive Node's connection to the target external archival storage system. For more information,
see the Administrator Guide.
If any Archive Nodes will use Tivoli Storage Manager as the external archival storage system,
you must configure Tivoli Storage Manager. For more information, see the "Integrating Tivoli
Storage Manager" section in the Administrator Guide.

•

Integrate and test API client applications with your StorageGRID Webscale system.
You need to configure the API client applications you use to upload objects to your StorageGRID
Webscale system. For more information, see the appropriate guide for the API you will be using:
◦

If you are using the S3 API, see the Simple Storage Service Implementation Guide.

◦

If you are using the Swift API, see the Swift Implementation Guide.

◦

If you are using the CDMI API, see Cloud Data Management Interface Implementation
Guide.

If your installation includes StorageGRID Webscale appliance Storage Nodes, use SANtricity
Storage Manager to complete the following tasks:
•

Connect to each StorageGRID Webscale appliance.

•

Verify receipt of AutoSupport data.

For details, see the StorageGRID Webscale and SANtricity Storage Manager documentation on the
NetApp Support Site.
Optional tasks
•

Configure email notifications.
You can configure the mailing lists and contents of notification emails for system alarms and
service status changes. For more information, see the “Configuring notifications” section in the
Administrator Guide.

Where to go next | 41

•

Configure SNMP monitoring.
You can configure the settings for the Simple Network Management Protocol (SNMP) agent used
to monitor system status. For more information, see the “Configure SNMP monitoring” section in
the Administrator Guide.

•

Reconfigure IP addresses.
If any of the grid node IP addresses have changed since you planned your deployment (and
generated the SAID package), you need to updated them. For details, see the “Change IP
Addresses” section in the Maintenance Guide for OpenStack Deployments.

•

Configure storage encryption.
You can turn on encryption for stored objects, if required. For more information, see the
“Configure stored object encryption” section in the Administrator Guide.

•

Configure storage compression.
You can turn on compression to reduce the size of stored objects, if required. For more
information, see the “Configure stored object compression” section in the Administrator Guide.

•

Configure access to audit shares.
You can configure access to the system for auditing purposes, either through a Common Internet
File System (CIFS) or NFS (Network File System) file share. For more information, see
“Configuring audit client access” in the Administrator Guide.

Related information

StorageGRID Webscale 10.3 Administrator Guide
StorageGRID Webscale 10.3 Audit Message Reference
StorageGRID Webscale 10.3 Cloud Data Management Interface Implementation Guide
StorageGRID Webscale 10.3 Documentation Matrix
StorageGRID Webscale 10.3 Grid Primer
StorageGRID Webscale 10.3 Maintenance Guide for OpenStack Deployments
StorageGRID Webscale 10.3 Release Notes
StorageGRID Webscale 10.3 Simple Storage Service Implementation Guide
StorageGRID Webscale 10.3 Swift Implementation Guide
StorageGRID Webscale 10.3 Troubleshooting Guide
NetApp Documentation: SANtricity Storage Manager
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Automating the installation
This section details automatic deployment and installation using the deployment tool and config files.
Another method of automatic installation is detailed in the "StorageGRID Webscale API overview"
section.
About this task

You can automate the deployment of the OpenStack virtual grid nodes for your StorageGRID
Webscale system using a bash script provided and a configuration file, which you modify for the
settings for your specific configuration. You can also automate the configuration of your
StorageGRID Webscale appliances using the script provided. You can specify the information to use
by modifying the sample INI configuration file, so that you do not have to create the file from
scratch. Subsequent to deployment, you can either configure the grid manually by browsing to the IP
of the Primary Admin node, or you may also automate this configuration using a separate script and
config file.

Creating a Nova flavor
An OpenStack Nova flavor is a virtual hardware template. You must create a flavor to customize the
hardware profile used to create grid nodes, so that you can have precise control over the resources
used.
Before you begin

You must have Administrator rights to the OpenStack installation to create a Nova flavor. If you do
not have Administrator rights, you must have an administrator create the required flavor.
About this task
Note: You must create a new flavor or use an existing flavor that meets or exceeds the values used
below. Another alternative is to use the /openstack/flavor.yaml template file included in the
StorageGRID Webscale download file (.tgz) to create the Nova flavor entry.
Note: Using the flavor YAML template may require the installation of a Heat template patch, and
this requires OpenStack admin access. You might have to request the flavor be created by an admin
if you are installing as a tenant user.
Steps

1. Sign in to the OpenStack Dashboard.
2. Select Admin > Flavors.
3. Click Create Flavor.
4. In the Create Flavor dialog box, enter the flavor details:
•

Name: Specify a descriptive name for the flavor.

•

ID: Ensure that “auto” is specified.

•

VCPUs: Specify the appropriate number of virtual CPUs for your deployment. The
recommended minimum for production systems is 8vCPUs.

•

RAM (MB): Specify the appropriate amount of RAM for your deployment. The
recommended minimum for production systems is 24GB RAM.
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•

Root Disk (GB): Specify 0.

•

Ephemeral Disk (GB): Specify 0.

•

Swap Disk (MB): Specify 0.

5. Click Create Flavor.

Guidelines and best practices for automated installations
•

You must have access to a Linux/Unix system with Bash 3.2 or higher.

•

You must already have the necessary OpenStack Heat and/or OpenStack command line client
applications installed and configured. The separate OpenStack Heat command line client is
required for supported releases prior to the Liberty release.

•

You must have an OpenStack tenant account to deploy to.

Information to gather about your deployment environment
You must gather information on your network configuration and OpenStack accounts before
proceeding with the automatic installation.
Information to gather during the assessment
You must access the deployment environment and collect the following information:
•

The Openstack user account and password with appropriate permissions to complete the
deployment. You need Admin rights to create a flavor.

•

The identifier for the OpenStack tenant you will deploy to. For example: --os-tenant-id
a9e21022382042ba8f951d2f259add66 or --os-tenant-name SGWS-Tenant

•

The URL of the identity endpoint. For example: --os-auth-url http://
10.224.4.201:5000/v2.0/

•

The name of the OpenStack image created for use with your StorageGRID Webscale system.

•

The name of the OpenStack flavor created for use with your StorageGRID Webscale system, or
determine if the built-in m1.xlarge flavor is appropriate for your needs.

•

The name of the OpenStack network created for your StorageGRID Webscale grid.

•

Determine whether your network will use Static or DHCP configuration:
◦

If you are using static IP address allocation, you need to know the name of the network and
the required networking details (IP address, gateway, network mask) for each grid node.

◦

If you are using DHCP for IP address allocation, you only need to know the name of the
network.

•

For virtual machine-based Storage Nodes, you need to define the number and size of storage
volumes (rangeDBs) to add, and ensure that the appropriate storage is configured.

•

The following information is required to configure your grid:
◦

Grid License

◦

Network Time Protocol (NTP) server IP addresses
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◦

Domain Name System (DNS) server IP addresses

◦

Grid topology information

Defining the configuration file for your deployment
You can specify the information to use to deploy your StorageGRID Webscale system in a
configuration file used by the deploy-openstack-heat.sh script by modifying the sample
configuration file, so that you do not have to create file from scratch.
Before you begin

•

•

•

You must have created the following for your OpenStack project:
◦

The StorageGRID Webscale image to use when deploying grid nodes

◦

The flavor (virtual hardware profile) to use, unless you will use the default m1.xlarge flavor

◦

The network you will use for your deployment

◦

The security group you will use for your deployment

You must have gathered the following information to provide in the configuration file:
◦

The OpenStack authentication URL

◦

The username and password required to access OpenStack

◦

The OpenStack tenant account ID where you want to deploy the virtual machines

◦

The network, IP address, gateway, and network mask for each grid node if you are using the
Static IP address option

◦

The IP address of the primary Admin Node

◦

The number and capacity of the disks to be used for storage on Storage Nodes

You can provide the following either in the configuration file, or you can use standard OpenStack
variables provided in the tenant RC file.
◦

The OpenStack authentication URL

◦

The username and password required to access OpenStack

◦

The OpenStack tenant account ID where you want to deploy the virtual machines

Steps

1. Save a copy of the sample configuration file (deploy-openstack-heat.sample.ini) as
deploy-openstack-heat.ini in the same directory as deploy-openstack-heat.sh.
2. Open deploy-openstack-heat.ini, and enter all of the information required to deploy your
StorageGRID Webscale system.
The configuration file includes a general section that applies to the configuration of the
OpenStack environment, and individual sections for each grid node in your StorageGRID
Webscale system.
The general section must include the following information:
•

IMAGE: The name of a predefined Glance image to use as the template for StorageGRID
Webscale grid nodes. You can override this setting on the command line by specifying -glance-image image_name. If the Glance image does not already exist the .vmdk is
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uploaded automatically. If the Glance image already exists the entry is used, but the file is not
uploaded. In order for automatic uploads to work, you must have the OpenStack command
line client application installed. Otherwise, you need to upload the file manually to OpenStack
using the command line, or by adding the image in OpenStack Dashboard using the Copy
Data option.
•

FLAVOR: The name of a predefined Nova flavor created for the StorageGRID Webscale
deployment. You can alternatively use the built-in m1.xlarge flavor.

•

GRID_NETWORK_TARGET: The name of a predefined OpenStack network to use for the
StorageGRID Webscale grid.

•

OS_:
◦

--os-auth--url: The authentication URL to use to access the OpenStack system. For

example: http://openstack.example.com:5000/v2.0/
◦

--os-tenant-name or --os-tenant-id: The name of the OpenStack tenant, or the

GUID associated with the tenant.
•

OS_USERNAME: (Optional) The OpenStack username with the necessary rights to deploy
the StorageGRID Webscale grid nodes to the tenant. The best practice is to omit this
information from the .ini file. This value is normally provided by the RC file.

•

OS_PASSWORD: (Optional) The password for the specified OpenStack username. The best
practice is to omit this information from the .ini file. This value is normally provided by the
RC file.

3. When you have entered and verified all of the necessary information, save and close the file.

Configuration file settings
You must understand the deployment information to enter in the configuration file, so you can deploy
grid node virtual machines with all of the required settings for your infrastructure. The config file
format lists global variables first, and then node-specific parameters are listed in sections defined by
node name.
Global parameters
Global parameters can be applied to all grid nodes, and these override individual settings. However,
section settings override global parameters. Node-specific settings can be applied to individual node
types as listed below. You can start with the sample INI config file and modify it to establish system
settings. Refer to the INI config file for detailed instructions.
OpenStack deployment tool arguments
You can apply deployment tool arguments as global settings, or you can apply arguments individually
to specific nodes.
Note: For most OpenStack users, these values are set in the environment, and they do not need to

be specified in the file or on the command line.
OS_ARGUMENTS = --os_tenant_id=id --os_auth_url=url
--os-username=username --os-password=password

Using --os-username and --os-password are not recommended because it will be visible with the ps
command.

46 | StorageGRID Webscale 10.3 Installation Guide for OpenStack Deployments

The best practice is to secure the configuration file and use the OS_USERNAME and
OS_PASSWORD commands in the global section. For example:
OS_USERNAME = username
OS_PASSWORD = password

Network
The OpenStack networks you use for StorageGRID Webscale must exist at installation time, and you
need to specify the networks either in the global section, or for each grid node. To define the network
name and configuration globally, enter them before you define any grid nodes.
The following networks can be configured:
•

Grid network: Required. Used for all internal StorageGRID Webscale traffic. All hosts on the
grid network must be able to talk to all other hosts. DHCP is the default value, and the
NETWORK_CONFIG option can be omitted if DHCP will be used.

•

Admin network: Optional. A closed network used to provide for maintenance and
administration. This is typically a private network, and it may not be routable between sites. This
network is disabled by default.

•

Client network: Optional. An open network used to provide access to client applications.
Enables grid nodes to communicate with any subnet reachable through the local gateway. The
client network only becomes operational after a grid node has joined the grid. This network is
disabled by default.

For a grid node to be on a particular network, it must have a dedicated interface (eth0, etc.), IP
address, subnet mask, and gateway for that network. A grid node cannot have more than one interface
on the same network.
Security Group
You must create and configure a security group to enable the necessary network access for the
StorageGRID Webscale system. You have two options for creating the required security group:
•

You can manually set up the security group in OpenStack Dashboard, and then specify the name
in the SECURITY_GROUP parameter. For more information, see Creating a security group on
page 17.

•

You can have the deployment tool create the security group automatically by specifying a security
group name in the SECURITY_GROUP parameter. If the security group does not exist, it is
created by the deployment tool. For this option to work, you must already have OpenStack
command line client application installed and configured.

•

You have the option to omit SECURITY_GROUP, in which case OpenStack will use the default
security group (typically called "default"). You can then modify the default and not specify a
value here.
SECURITY_GROUP = StorageGRID-Security

Image
Root images are templates for virtual machine file systems. You must create a root image that
provides a template for creating StorageGRID Webscale grid nodes. You have two options for
creating the required root image:
•

You can have the deployment tool create the image automatically by specifying the image name
in the IMAGE parameters and allow the deployment tool to upload the image for you. To do this,
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the image name must be the same as the base name of the .vmdk file without the extension, and
must be located in the directory specified by SOURCE (which defaults to "."). If the named image
already exists in Glance, it will not be uploaded again. You can override this setting on the
command line by specifying --glance-image image_name.
•

You can manually upload the .vmdk to Glance to create the root image. For more information on
creating the image in OpenStack Dashboard, see Uploading a Glance image on page 16.
IMAGE = NetApp-SG-10.3.0-20160607.1341.f8457d3

Flavor
You must create OpenStack flavor to use to deploy your StorageGRID Webscale system, or
determine if the built-in m1.xlarge flavour is appropriate for your needs. For information on creating
a flavor in OpenStack Dashboard, see Creating a Nova flavor on page 18.
FLAVOR = StorageGRID-Node

Node-specific parameters
The following are mandatory attributes for each node:
•

NODE_TYPE

•

GRID_NETWORK_TARGET

•

If GRID_NETWORK_CONFIG is STATIC, also GRID_NETWORK_IP,
GRID_NETWORK_MASK, and possibly GRID_NETWORK_GATEWAY are required.

All nodes are also required to have GRID_NETWORK_TARGET and GRID_NETWORK_MASK,
but these can be set globally, along with the optional GRID_NETWORK_GATEWAY, unless they
differ across sites.
Primary Admin Node
The following are mandatory settings for the Admin Node:
•

NODE_TYPE=VM_Admin_Node

•

ADMIN_ROLE=Primary

•

GRID_NETWORK_IP set

The Primary Admin Node can also accept optional ADMIN and CLIENT network configurations.
[DC1-ADM1]
ADMIN_ROLE = Primary
NODE_TYPE = VM_Admin_Node
GRID_NETWORK_TARGET =
SG-Grid-Network
GRID_NETWORK_IP = 10.1.0.2
GRID_NETWORK_MASK = 255.255.255.0
GRID_NETWORK_GATEWAY = 10.1.0.1
ADMIN_NETWORK_CONFIG = STATIC
ADMIN_NETWORK_TARGET = SG-Grid-Network
ADMIN_NETWORK_IP = 10.3.0.2
ADMIN_NETWORK_MASK = 255.255.253.0
ADMIN_NETWORK_GATEWAY = 10.3.0.1
ADMIN_NETWORK_ESL = 172.16.0.0/21,172.17.0.0/21
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By default, Admin Nodes are assigned two additional 200GB hard disks for audit and database use.
You can increase these settings using the DISK parameter. For example:
DISK = INSTANCES=2, CAPACITY=300

Storage Node
The following are mandatory settings for the Storage Node:
•

NODE_TYPE=VM_Storage_Node

•

GRID_NETWORK_IP set

The Storage Node can also accept optional DISK arguments.
[DC1-S1]
GRID_NETWORK_TARGET =
SG-Grid-Network
GRID_NETWORK_IP = 10.1.0.3
GRID_NETWORK_MASK = 255.255.255.0
GRID_NETWORK_GATEWAY = 10.1.0.1

Archive Node
The following are mandatory settings for the Archive Node:
•

NODE_TYPE=VM_Archive_Node

•

GRID_NETWORK_IP set
[DC1-ARC1]
GRID_NETWORK_TARGET =
SG-Grid-Network
GRID_NETWORK_IP = 10.1.0.4
GRID_NETWORK_MASK = 255.255.255.0
GRID_NETWORK_GATEWAY = 10.1.0.1

API Gateway Node
The following are mandatory settings for the API Gateway Node:
•

NODE_TYPE=VM_API_Gateway

•

GRID_NETWORK_IP set
[DC1-G1]
GRID_NETWORK_TARGET =
SG-Grid-Network
GRID_NETWORK_IP = 10.1.0.5
GRID_NETWORK_MASK = 255.255.255.0
GRID_NETWORK_GATEWAY = 10.1.0.1

Non-primary Admin Node
The following are mandatory settings for the Non-primary Admin Node:
•

NODE_TYPE=VM_Admin_Node

•

ADMIN_ROLE=Non-Primary
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•

GRID_NETWORK_IP set
[DC2-ADM1]
ADMIN_ROLE = Non-Primary
GRID_NETWORK_TARGET =
SG-Grid-Network
GRID_NETWORK_IP = 10.1.0.6
GRID_NETWORK_MASK = 255.255.255.0
GRID_NETWORK_GATEWAY = 10.1.0.1

By default, Admin Nodes are assigned two additional 200GB hard disks for audit and database use.
You can increase these settings using the DISK parameter. For example:
DISK = INSTANCES=2, CAPACITY=300

Automatically deploying grid nodes in OpenStack
You can use the provided bash script to deploy your StorageGRID Webscale grid nodes in
OpenStack. Using the script allows you to create a repeatable deployment process, and may be more
time efficient in some situations.
Before you begin

•

You must already have access credentials for an OpenStack tenant account, and a project, to use
for your StorageGRID Webscale deployment.

•

You must already have a configuration file defined with the setting for your StorageGRID
Webscale system.

•

You must already have the necessary OpenStack Heat and/or OpenStack command line client
applications installed if you want to have the image uploaded automatically. The separate
OpenStack Heat command line client is required for supported releases prior to the Liberty
release.

Steps

1. Log in to the Linux machine you are using to run the bash script.
2. Run the bash script with the appropriate options for your environment.
For help with the script syntax and a list of the available parameters, enter
deploy-openstack-heat.sh --help

.
Example: Deploying all grid nodes
deploy-openstack-heat.sh --username=jsmith --password=pwd --glance-image
NetApp-SG-version-SHA.vmdk deploy-openstack-heat.ini

In the example, the name of the OpenStack glance image is specified. If the Glance image does
not exist, it is created and the .vmdk file is uploaded if the python-glanceclient command
line tool is available. If the Glance image exists, the existing entry is used the file is not uploaded.
The values specified on the command line override any settings specified in the .ini file.
Example: Deploying an individual grid node
deploy-openstack-heat.sh --username=jsmith --password=pwd --singlenode="DC1-S3" deploy-openstack-heat.ini
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You can use the single node deployment to complete the deployment of your grid if you deploy
all grid nodes, but one of the grid nodes fails to deploy because of an OpenStack error, or data
entry error in the grid node configuration information.
Result

The deployment is complete when the status for each node is “Passed”.
Deployment Summary
+-----------------------------+----------+----------------------+
| node
| attempts | status
|
+-----------------------------+----------+----------------------+
| DC1-ADM1
|
1 | Passed
|
| DC1-G1
|
1 | Passed
|
| DC1-S1
|
1 | Passed
|
| DC1-S2
|
1 | Passed
|
| DC1-S3
|
1 | Passed
|
+-----------------------------+----------+----------------------+

Automatically configuring StorageGRID Webscale appliance
Storage Nodes
You can use the configure-sga.py script to install and configure a StorageGRID Webscale
appliance Storage Node.
Before you begin

•

All StorageGRID Webscale appliance networking configuration has been completed.

Steps

1. Log in to the Linux machine you are using to run the bash script.
2. Run the bash script with the appropriate options for your environment.
configure-sga.py -a IP address --monitor-delta --start-install IP
address

For help with the script syntax and a list of the available parameters, enter
configure-sga.py --help

.
3. If you want to reboot the appliance, go to
http://<IP>:8080/reboot

and then click Reboot.

Automatically configuring your StorageGRID Webscale
system
About this task

Once your virtual nodes and appliance nodes are deployed, you can configure the StorageGRID
Webscale system. You can do this using the Grid Management Interface (see "Navigating to the Grid
Management Interface" in this guide). Alternatively, you can modify the sample configuration file
provided (configure-storagegrid.json) and use the configure-storagegrid.py python
script to perform this configuration.
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Steps

1. Log in to the Linux machine you are using to run the bash script.
2. Run the bash script with the appropriate options for your environment.
~jsmith/openstack/configure-storagegrid.py ~jsmith/openstack/configurestoragegrid.json --start-install
Result

Ensure that you back up the sgws-recovery-package.zip file that is generated during the
configuration process, and downloaded to the computer you are using to run the installation and
configuration process. For example, you can copy the provisioning data to a secure, backed up
network location and to a secure cloud storage location.
Attention: The Grid Provisioning archive file contains encryption keys and passwords that you can
use to obtain data from the StorageGRID Webscale system.
If you specified that random passwords should be generated, you need to extract the
Passwords.txt file and look for the passwords required to access your StorageGRID Webscale
system.
######################################################################
##### The StorageGRID "recovery package" has been downloaded as: #####
#####
./sgws-recovery-package.zip
#####
#####
Safeguard this file as it will be needed in case of a
#####
#####
StorageGRID node recovery.
#####
######################################################################

Your StorageGRID Webscale system is installed and configured when a confirmation message is
displayed.
StorageGRID has been configured and installed.
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StorageGRID Webscale Installation API overview
StorageGRID Webscale provides a REST API for performing grid installation tasks.
The Installation API is only available during the initial deployment of your StorageGRID Webscale
system, and in the event that you need to perform a primary Admin Node recovery.
StorageGRID Webscale Installation API Documentation
You access the StorageGRID Webscale Installation API documentation by navigating to the
installation web page on the primary Admin Node and selecting Help > API Docs in the web
application header.
StorageGRID Webscale uses Swagger for the REST API documentation. Swagger allows both
developers and non-developers to interact with the API in a UI that illustrates how the API responds
to parameters and options. This documentation assumes that you are familiar with standard Web
technologies and the JSON (JavaScript Object Notation) data format.
Attention: Operations performed via the Swagger documentation UI are real operations and

perform real actions on the grid.
API
Each of the REST API commands is comprised of the API's URL, an HTTP action, a URL
parameter, and an expected API response.
In the Swagger output, you see API details similar to the following:
The StorageGRID Webscale Installation API is separated into the following sections:
•

Grid details: Operations to configure grid-wide setting, such as grid name and license
information.

•

Passwords: Operations to define grid administration and provisioning passwords.

•

NTP servers: Operations to define network time protocol (NTP) servers.

•

DNS servers: Operations to define domain name system (DNS) servers.

•

Sites: Operations to add and configure sites.

•

Nodes: Operations to add and configure grid nodes.

•

Topology: Operations to retrieve the current grid topology.

•

Installation: Operations to start, cancel, or get the status of the current installation.
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Troubleshooting
This section includes troubleshooting topics to help you identify and solve problems that might occur
while installing your StorageGRID Webscale system.
If problems persist, contact technical support. The following are the main installation log files:
•

/var/local/log/install.log (found on all grid nodes)

•

/var/local/log/gdu-console.log (found on the primary Admin Node)

StorageGRID Webscale Appliance Installer errors
If you encounter issues during the StorageGRID Webscale appliance installation, you might find it
helpful to review troubleshooting information.

Failed to download new provisioning progress data
Issue
This message occurs when the installation cannot obtain provisioning data.
Cause
This could occur if the installation encounters a system or power failure.
Corrective action
1. Check the StorageGRID Webscale Appliance Installation web page:
•

Open a browser and enter http://Management_Port_IP:8080.
For the Management Port IP, enter the E5600SG controller Management Port 1 IP
address that was provisioned during the physical installation.
The StorageGRID Webscale Appliance Installation Home web page appears:

After you install the appliance, the status for each of the procedures on the web
page indicates that the procedure is complete.
•

Refresh the appliance installation web page.

2. Check the StorageGRID Webscale Installer web page:
•

Open a browser and enter the IP address configured when deploying StorageGRID
Webscale.
The StorageGRID Webscale installation page is displayed, listing the status of the
grid node installation.
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•

Click Modify an existing system.

•

Note the completion percentage.

3. Check for hardware errors in SANtricity Storage Manager.
4. If hardware errors appear in SANtricity Storage Manager, fix them and reboot the
appliance.
5. If hardware errors do not appear in SANtricity Storage Manager, obtain the installation
logs.
For details about logs, see the StorageGRID Webscale troubleshooting information.
6. If you cannot resolve the issue, contact technical support from the NetApp Support
Site at mysupport.netapp.com.

Failed to find Debian repository
Issue
Installation fails with a message indicating that the Debian operating system repository
cannot be found.
Cause
Two potential causes for this error have been identified:
1. The network settings for the Storage Node are incorrect.
During the Storage Node installation the appliance will use the grid configuration
settings. If these are incorrect, the installation will fail.
2. The Data Network Connection settings are incorrect.
During the configuration of the appliance, you must configure network settings for the
following:
•

Management Network Connection: This connection allows you to connect to the
installation page to configure and monitor the appliance during the install. This
connection is no longer available after the installation is complete.

•

Data Network Connection: This is the connection for the 10GbE interface on the
appliance. This is the grid interface, and installation is completed over this
interface. After the installation is complete, this interface handles grid traffic. It is
critical that this interface has connectivity to the primary Admin Node during the
installation The default route must be configured on this interface.

Corrective action
1. Verify that the network settings for the Storage Node are correct in your grid
configuration. If these settings are incorrect, you must correct them and start the
installation over again.
2. If you determine that the network settings for the Storage Node are correct in your grid
configuration, you must configure the network settings for the appliance again:
a. Reboot the appliance.
b. Open a browser and enter http://Management_Port_IP:8080.
For the Management Port IP, enter the E5600SG controller Management Port 1 IP
address that was provisioned during the physical installation.
The StorageGRID Webscale Appliance Installation Home web page appears.
c. Click Configure Network Connections.
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d. Specify the default gateway for the Data Network Connection, not the Management
Network Connection. If the primary Admin Node is on a separate network from the
appliance, and a specific rout is required, add any routing to the Data Network
Connection.
3. Verify that you can connect to the Data Network:
a. Connect to the appliance on port 8022 via ssh.
b. Ping the IP address of the primary Admin Node via the Data Network Interface
(br0), for example:
ping -I br0 192.168.10.55

Storage-related error during software installation
Issue
The StorageGRID Webscale Appliance Installer issues a storage-related error message,
such as
Cannot create volume group.

Cause
This could occur due to several possible reasons, including that the appliance is not cabled
correctly, an installation file is missing or corrupt, or a power failure occurred.
Corrective action
1. Ping the appliance:
ping E2700_controller_IP.

2. Check the logs on the E2700 controller.
3. In SANtricity, look at the status of the E2700 controller.
4. Check the StorageGRID Webscale Appliance Installation web page:
•

Open a browser and enter http://Management_Port_IP:8080.
For the Management Port IP, enter the E5600SG controller Management Port 1 IP
address that was provisioned during the physical installation.
The StorageGRID Webscale Appliance Installation Home web page appears:

•

Click Reboot to reboot the appliance.

5. If this does not resolve the connection issue, contact technical support from the
NetApp Support Site at mysupport.netapp.com.
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Glossary
ACL
Access control list. Specifies which users or groups of users are allowed to access an
object and what operations are permitted, for example, read, write, and execute.
ADC service
Administrative Domain Controller. The ADC service maintains topology information,
provides authentication services, and responds to queries from the LDR, CMN, and CLB
services. The ADC service is present on each of the first three Storage Nodes installed at a
site.
ADE
Asynchronous Distributed Environment. Proprietary development environment used as a
framework for services within the StorageGRID Webscale system.
Admin Node
The Admin Node provides services for the web interface, system configuration, and audit
logs. See also, primary Admin Node.
Amazon S3
Proprietary web service from Amazon for the storage and retrieval of data.
AMS service
Audit Management System. The AMS service monitors and logs all audited system events
and transactions to a text log file. The AMS service is present on the Admin Node.
API Gateway Node
An API Gateway Node provides load balancing functionality to the StorageGRID
Webscale system and is used to distribute the workload when multiple client applications
are performing ingest and retrieval operations. API Gateway Nodes include a Connection
Load Balancer (CLB) service.
ARC service
Archive. The ARC service provides the management interface with which you configure
connections to external archival storage such as the cloud through an S3 interface or tape
through TSM middleware. The ARC service is present on the Archive Node.
Archive Node
The Archive Node manages the archiving of object data to an external archival storage
system.
atom
Atoms are the lowest level component of the container data structure, and generally
encode a single piece of information.
audit message
Information about an event occurring in the StorageGRID Webscale system that is
captured and logged to a file.
BASE64
A standardized data encoding algorithm that enables 8-bit data to be converted into a
format that uses a smaller character set, enabling it to safely pass through legacy systems
that can process only basic (low order) ASCII text excluding control characters. See RFC
2045 for more details.
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bundle
A structured collection of configuration information used internally by various
components of the StorageGRID Webscale system. Bundles are structured in container
format.
Cassandra
An open-source database that is scalable and distributed, provides high availability, and
handles large amounts of data across multiple servers.
CBID
Content Block Identifier. A unique internal identifier of a piece of content within the
StorageGRID Webscale system.
CDMI
Cloud Data Management Interface. An industry-standard defined by SNIA that includes a
RESTful interface for object storage. For more information, see www.snia.org/cdmi.
CIDR
Classless Inter‐Domain Routing. A notation used to compactly describe a subnet mask
used to define a range of IP addresses. In CIDR notation, the subnet mask is expressed as
an IP address in dotted decimal notation, followed by a slash and the number of bits in the
subnet. For example, 192.0.2.0/24.
CLB service
Connection Load Balancer. The CLB service provides a gateway into the StorageGRID
Webscale system for client applications connecting through HTTP. The CLB service is
part of the API Gateway Node.
Cloud Data Management Interface
See CDMI.
CMN service
Configuration Management Node. The CMN service manages system‐wide configurations
and grid tasks. The CMN service is present on the primary Admin Node.
CMS service
Content Management System. The CMS service carries out the operations of the active
ILM policy’s ILM rules, determining how object data is protected over time. The CMS
service is present on the Storage Node.
command
In HTTP, an instruction in the request header such as GET, HEAD, DELETE, OPTIONS,
POST, or PUT. Also known as an HTTP method.
container
Created when an object is split into segments. A container object lists the header
information for all segments of the split object and is used by the LDR service to assemble
the segmented object when it is retrieved by a client application.
content block ID
See CBID.
content handle
See UUID.
CSTR
Null‐terminated, variable-length string.
DC
Data Center site.
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DDS service
Distributed Data Store. The DDS service interfaces with the distributed key-value store
and manages object metadata. It distributes metadata copies to multiple instances of the
distributed key-value store so that metadata is always protected against loss.
distributed key value store
Data storage and retrieval that unlike a traditional relational database manages data across
grid nodes.
Enablement Layer
Used during installation to customize the Linux operating system installed on each grid
node. Only the packages needed to support the services hosted on the grid node are
retained, which minimizes the overall footprint occupied by the operating system and
maximizes the security of each grid node.
Fibre Channel
A networking technology primarily used for storage.
GPT
Grid Provisioning Tool. A software tool included with StorageGRID Webscale software
that permits you to provision a StorageGRID Webscale system for installation,
maintenance, or expansion. GPT creates and maintains an encrypted repository of
information about the system that is required to maintain the StorageGRID Webscale
system and recover failed grid nodes.
Grid ID signed text block
A BASE64 encoded block of cryptographically signed data that contains the grid ID. See
also, provisioning.
grid node
The basic software building block for the StorageGRID Webscale system, for example,
Admin Node or Storage Node. Each grid node type consists of a set of services that
perform a specialized set of tasks.
grid task
System‐wide scripts used to trigger various actions that implement specific changes to the
StorageGRID Webscale system. For example, most maintenance and expansion
procedures involve running grid tasks. Grid tasks are typically long‐term operations that
span many entities within the StorageGRID Webscale system. See also, Task Signed Text
Block.
ILM
Information Lifecycle Management. A process of managing content storage location and
duration based on content value, cost of storage, performance access, regulatory
compliance, and other factors. See also, Admin Node and storage pool.
LAN
Local Area Network. A network of interconnected computers that is restricted to a small
area, such as a building or campus. A LAN can be considered a node to the Internet or
other wide area network.
latency
Time duration for processing a transaction or transmitting a unit of data from end to end.
When evaluating system performance, both throughput and latency need to be considered.
See also, throughput.
LDR service
Local Distribution Router. The LDR service manages the storage and transfer of content
within the StorageGRID Webscale system. The LDR service is present on the Storage
Node.

Glossary | 59

LUN
See object store.
metadata
Information related to or describing an object stored in the StorageGRID Webscale
system; for example, ingest time.
namespace
A set whose elements are unique names. There is no guarantee that a name in one
namespace is not repeated in a different namespace.
nearline
A term describing data storage that is neither “online” (implying that it is instantly
available, like spinning disk) nor “offline” (which can include offsite storage media). An
example of a nearline data storage location is a tape that is loaded in a tape library, but is
not mounted.
NFS
Network File System. A protocol (developed by SUN Microsystems) that enables access
to network files as if they were on local disks.
NMS service
Network Management System. The NMS service provides a web-based interface for
managing and monitoring the StorageGRID Webscale system. The NMS service is present
on the Admin Node. See also, Admin Node.
node ID
An identification number assigned to a service within the StorageGRID Webscale system.
Each service (such as an NMS service or ADC service) must have a unique node ID. The
number is set during system configuration and tied to authentication certificates.
NTP
Network Time Protocol. A protocol used to synchronize distributed clocks over a variable
latency network, such as the Internet.
object
An artificial construct used to describe a system that divides content into data and
metadata.
object storage
An approach, where stored data is accessed by unique identifiers rather than by a user‐
defined hierarchy of directories and files. Each object has both data (for example, a
picture) and metadata (for example, the date the picture was taken). Object storage
operations act on entire objects as opposed to reading and writing bytes as is commonly
done with files, and provided via APIs or HTTP instead of NAS (CIFS/NFS) or block
protocols (iSCSI/ FC/FCOE).
object store
A configured file system on a disk volume. The configuration includes a specific directory
structure and resources initialized at system installation.
object segmentation
A StorageGRID Webscale process that splits a large object into a collection of small
objects (segments) and creates a segment container to track the collection. The segment
container contains the UUID for the collection of small objects as well as the header
information for each small object in the collection. All of the small objects in the
collection are the same size. See also, segment container.
OID
Object Identifier. The unique identifier of an object.
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primary Admin Node
Admin Node that hosts the CMN service. There is one per StorageGRID Webscale
system. See also, Admin Node.
provisioning
The process of generating a new or updated SAID package and GPT repository. See also,

SAID.
quorum
A simple majority: 50% + 1. Some system functionality requires a quorum of the total
number of a particular service type.
SAID
Software Activation and Integration Data. Generated during provisioning, the SAID
package contains site‐specific files and software needed to install a StorageGRID
Webscale system.
SATA
Serial Advanced Technology Attachment. A connection technology used to connect server
and storage devices.
SCSI
Small Computer System Interface. A connection technology used to connect servers and
peripheral devices, such as storage systems.
segment container
An object created by the StorageGRID Webscale system during the segmentation process.
Object segmentation splits a large object into a collection of small objects (segments) and
creates a segment container to track the collection. A segment container contains the
UUID for the collection of segmented objects as well as the header information for each
segment in the collection. When assembled, the collection of segments creates the original
object. See also, object segmentation.
Server
Used when specifically referring to hardware. Might also refer to a virtual machine.
Service
A unit of the StorageGRID Webscale system, such as the ADC service, NMS service, or
SSM service. Each service performs unique tasks critical to the normal operations of a
StorageGRID Webscale system.
SQL
Structured Query Language. An industry-standard interface language for managing
relational databases. An SQL database is one that supports the SQL interface.
ssh
Secure Shell. A UNIX shell program and supporting protocols used to log in to a remote
computer and execute commands over an authenticated and encrypted channel.
SSM
Server Status Monitor. A component of the StorageGRID Webscale software that monitors
hardware conditions and reports to the NMS service. Every grid node runs an instance of
the SSM service.
SSL
Secure Socket Layer. The original cryptographic protocol used to enable secure
communications over the Internet. See also, TLS.
Storage Node
The Storage Node provides storage capacity and services to store, move, verify, and
retrieve objects stored on disks.
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Storage pool
The element of an ILM rule that determines the location where an object is stored.
StorageGRID Webscale
A registered trademark of NetApp Inc. for their object storage grid architecture and
software system.
Storage volume
See object store
Task Signed Text Block
A BASE64 encoded block of cryptographically signed data that provides the set of
instructions that define a grid task.
TCP/IP
Transmission Control Protocol/Internet Protocol. A process of encapsulating and
transmitting packet data over a network. It includes positive acknowledgment of
transmissions.
throughput
The amount of data that can be transmitted or the number of transactions that can be
processed by a system or subsystem in a given period of time. See also, latency.
TLS
Transport Layer Security. A cryptographic protocol used to enable secure communications
over the Internet. See RFC 2246 for more details.
transfer syntax
The parameters, such as the byte order and compression method, needed to exchange data
between systems.
Tivoli Storage Manager
IBM storage middleware product that manages storage and retrieval of data from
removable storage resources.
URI
Universal Resource Identifier. A generic set of all names or addresses used to refer to
resources that can be served from a computer system. These addresses are represented as
short text strings.
UTC
A language‐independent international abbreviation, UTC is neither English nor French. It
means both “Coordinated Universal Time” and “Temps Universel Coordonné.” UTC
refers to the standard time common to every place in the world.
UUID
Universally Unique Identifier. Unique identifier for each piece of content in the
StorageGRID Webscale system. UUIDs provide client applications with a content handle
that permits them to access content in a way that does not interfere with the StorageGRID
Webscale system’s management of that same content. A 128‐bit number which is
guaranteed to be unique. See RFC 4122 for more details.
Virtual machine (VM)
A software platform that enables the installation of an operating system and software,
substituting for a physical server and permitting the sharing of physical server resources
among several virtual servers.
XFS
A scalable, high-performance journaled file system originally developed by Silicon
Graphics.
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WAN
Wide area network. A network of interconnected computers that covers a large geographic
area, such as a country.
XML
Extensible Markup Language. A text format for the extensible representation of structured
information; classified by type and managed like a database. XML has the advantages of
being verifiable, human readable, and easily interchangeable between different systems.
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How to send comments about documentation and
receive update notifications
You can help us to improve the quality of our documentation by sending us your feedback. You can
receive automatic notification when production-level (GA/FCS) documentation is initially released or
important changes are made to existing production-level documents.
If you have suggestions for improving this document, send us your comments by email.

doccomments@netapp.com
To help us direct your comments to the correct division, include in the subject line the product name,
version, and operating system.
If you want to be notified automatically when production-level documentation is released or
important changes are made to existing production-level documents, follow Twitter account
@NetAppDoc.
You can also contact us in the following ways:
•

NetApp, Inc., 495 East Java Drive, Sunnyvale, CA 94089 U.S.

•

Telephone: +1 (408) 822-6000

•

Fax: +1 (408) 822-4501

•

Support telephone: +1 (888) 463-8277
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